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Preface
Thank you for purchasing the Garmin® 
zūmo™. 

Manual Conventions
When you are instructed to “touch” 
something, use your finger to touch an 
item on the screen. You will see arrows 
(>) used in the text. They indicate that 
you should touch a series of items. For 
example, if you see “touch Where to > 
Favorites,” you should touch the Where 
to button, and then touch Favorites. 

Contact Garmin
Contact Garmin if you have any 
questions while using your zūmo. In 
the USA, contact Garmin Product 
Support by phone: 913/397.8200 or 
800/800.1020, Monday–Friday, 8 AM–5 
PM Central Time; or go to  
www.garmin.com/support, and click 
Product Support.

In Europe, contact Garmin (Europe) Ltd. 
at +44 (0) 870.8501241 (outside the UK) 
or 0808 2380000 (UK only).

myGarmin™ 
Go to http://my.garmin.com to access the 
latest services for your Garmin products. 
From the myGarmin Web site, you can:
•	 Register your Garmin unit.
•	 Subscribe to online services for safety 

camera information (see page 42).
•	 Unlock optional maps.
Return to myGarmin often for new 
Garmin product services. 

About Google Earth™ 
Go to http://earth.google.com to 
download the Google Earth application. 
With Google Earth installed on your 
computer, you can view waypoints, 
tracks, and routes saved in MapSource®. 
From the View menu, select View in 
Google Earth.

www.garmin.com/support/
http://my.garmin.com
http://earth.google.com
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Product Warnings
When your zūmo is not in the motorcycle mount, use the weather cap 
to prevent damage to the connector.
See the Important Safety and Product Information guide for product 
warnings and legal information.

Tips for Protecting Your zūmo
•	 Carry and store your zūmo in the included carrying case (zūmo 

450 only). 
•	 Do not store your zūmo where prolonged exposure to extreme temperatures can occur (such as in 

the trunk of a car), because it can cause permanent damage. 
•	 Though a PDA stylus can also be used to operate the touch screen, never attempt this while 

operating a vehicle. Never use a hard or sharp object to operate the touch screen or damage may 
result. 

•	 Avoid dropping your unit and operating it in extreme high-shock and high-vibration 
environments. Your zūmo contains sensitive electronic components that can be permanently 
damaged if exposed to excessive shock or vibration outside normal motorcycle use.

•	 To avoid theft, remove the zūmo and mount from sight when not in use. 
•	 Use the Garmin Lock™ feature. See page 10.

Declaration of Conformity
Hereby, Garmin declares that this product is in compliance with the essential requirements and other 
relevant provisions of Directive 1999/5/EC. 
To view the full Declaration of Conformity, see the Garmin Web site for your Garmin product:  
www.garmin.com/products/zumo400 or www.garmin.com/products/zumo450. Click Manuals, and 
then select the Declaration of Conformity.

 Important Information

Weather cap

Connector

www.garmin.com/products/zumo/
www.garmin.com/products/zumo400
www.garmin.com/products/zumo450
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Getting Started

Looking at Your zūmo
A.	  Power button
B.	  Zoom in, raise volume, or 

increase brightness.
C.	  Zoom out, lower volume, or 

decrease brightness.
D.	  Page button—scroll through 

the Map, Trip Information, and 
Media Player pages. Press and 
hold to adjust brightness. 

E.	  Speak button—press 
to adjust volume 
level. Press and hold 
to announce voice 
directions.

SD card 
slot

Mini-USB port for AC adapter, 
USB Mass Storage mode, and 

updating software

A

B
C

D
E

MCX connector 
under weather 
cap (see page 

45)

Battery pack
(see page 44)
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zūmo Tips and Shortcuts
•	 Touch and hold  to quickly 

return to the Menu page.
•	 Press  to return to the Map page. 
•	 Touch  and  to see more 

choices.
•	 Touch  to adjust settings such 

as volume, brightness, language, and 
keyboard.

Adjusting the �Volume
Press , and then use  and  to 
adjust the volume. For advanced volume 
settings, touch  > Volume. 

Adjusting the �Brightness
Press and hold , and then use  
and  to adjust the brightness. See 
page 35 for additional display settings.

Quick Links
•	 Finding an address: page 11
•	 Viewing the Map page: page 20
•	 Using the Garmin Lock™ anti-

theft feature: page 10
•	 Listening to MP3 files: pages 

28–29 
•	 Transferring files to your zūmo: 

pages 25–27
•	 zūmo audio options: see page 37
•	 Frequently asked questions: page 

47
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Mounting the zūmo on Your Motorcycle
	Warning: The terms of the Garmin Warranty require that the power cable 
with bare wire leads be installed by experienced installers having the proper 
knowledge of automotive electrical systems and skill in the use of special tools 
or hardware required for installation.

1: Connect Power to the Mount
Select a suitable and secure location to mount the zūmo on your motorcycle based on 
available power sources and safe cable routing.

Bare wires 
with inline 

fuse for power 
connection

Power connector

About Connecting Audio
Standard jacks for microphone (2.5 mm) and audio out (3.5 mm) are located on the 
left side of the mount (under a weather cap). When connecting your audio system to 
the zūmo, be sure to consider the pathways needed to route the necessary cables. For 
more information, see page 37.

2: Install the Handlebar Base
The zūmo includes parts for two handlebar installation solutions. Custom mounts can 
require additional hardware (www.ram-mount.com).

http://www.ram-mount.com/
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A) To install the U-bolt and handlebar 
base:
1.	 Place the U-bolt around the handlebar, 

and thread the ends through the handlebar 
base.

2.	 Tighten the nuts to secure the base. Do 
not overtighten. 

	Note: The recommended torque 
is 50in-lb (5.7 N-m). Do not exceed 
maximum torque of 80in-lb (9 N-m).

B) To install the handlebar base to the clutch/brake clamp bracket:
	Note: Both 1/4” standard and M6 bolts are included. Match the size of the 
factory bolts on your clutch/brake clamp bracket.

1.	 Remove the two factory bolts 
on your clutch/brake clamp 
bracket. 

2.	 Thread the new bolts through 
the handlebar base, spacers, 
and clamp bracket. 

3.	 Tighten the bolts to secure the 
base. 

Handlebar 
base

Handlebar 

U-bolt

Clutch/brake 
clamp bracket

Handlebar 
base

Spacers
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3: Attach the Base Plate 
to the zūmo Mount
1.	 Thread the M4 x 40 mm 

flathead bolts and nuts to 
attach the base plate to the 
zūmo mount. 

2.	 Tighten the nuts to secure the 
base plate.

4: Attach the 
Base Plate to the 
Handlebar Base
1.	 Align the ball of the 

handlebar base and the 
ball of the base plate 
with the double-socket 
arm.

2.	 Tighten the knob slightly.
3.	 Adjust for better viewing 

and operation. 
4.	 Tighten the knob to 

secure the mount.

zūmo mount

Base plate

Weather cap

Knob

Double-
socket arm

Handlebar base

Weather cap

Base plate

Power 
socket

Mini-USB 
port

zūmo mount
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5: Install the zūmo 
in the Mount
1.	 Plug the power cable 

into the zūmo mount. 
For a better seal, 
tighten the screws on 
the power connector. 

2.	 Flip the lever up. 
3.	 Flip the weather cap 

down and under 
(magnetic).

4.	 Place the zūmo into 
the mount, and flip the 
lever down. 

5.	 Tighten the security 
screw.

About the Security Screwdriver
Use the security screw to better secure 
the zūmo to the mount. You can connect 
the screwdriver to your key chain for 
easy access. 

Leverzūmo mount

Power 
cable

Security screw

Security screwdriver
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Configuring Your zūmo
To turn on your zūmo, press and hold . Follow the on-screen instructions to 
configure your zūmo. 

Acquiring Satellites
Go outdoors to an open area, out of garages, and away from tall buildings. Turn on the 
zūmo. Acquiring satellite signals may take a few minutes. 
The  bars indicate GPS satellite strength. When the bars are green, your zūmo 
has acquired satellite signals, and you can start navigating. 

Using Your zūmo
A.	 Displays satellite strength.
B.	 Displays battery status.
C.	 Touch to find a destination.
D.	 Touch to view the Map page.
E.	 Touch to view traffic incidents (requires 

receiver and subscription).
F.	 Touch to open the Media Player.
G.	 Touch to adjust the zūmo’s settings.

A B

C D

E F G
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Finding Your Destination 
The  Where to menu provides several different categories for you to use when you 
search for locations. 

➍Select a destination. Enjoy the route! ➏Touch Go.➎

➌	➋➊ Select a sub-
category. 

Select a category. Touch  Where to.

Tip: Touch  and  to see more choices.
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Following Your Route
As you travel, your zūmo guides you to your destination with voice prompts, arrows 
on the map, and directions at the top of the Map page. If you depart from the original 
route, your zūmo recalculates the route and provides new directions. 

A checkered flag marks your 
destination.

Follow the arrows as you 
take turns.

Your route is marked with a 
purple line.

Adding a Stop to Your Route
You can add a stop to your route. The zūmo gives you directions to the stop and then to 
your final destination. 
1.	 With a route active, touch Menu on the Map page, and 

touch  Where to. 
2.	 Search for the extra stop. 
3.	 Touch Go.
4.	 Touch Add as Via Point to add this stop before your 

destination. Touch Set as new Destination to make 
this your new final destination. 



10	 zūmo 400/450 Owner’s Manual

Getting Started

Adding a �������Detour
If a road on your route is closed, you can 
take a detour. 
1.	 With a route active, touch Menu. 
2.	 Touch Detour. 

Stopping the Route
1.	 With a route active, touch Menu. 
2.	 Touch Stop. 

Taking a Better Route
As you approach your destination, the 
zūmo evaluates road options, to find a 
better route. If the zūmo finds a better 
route,  or  appears in the right 
corner of the map. Touch  or  to 
take the better route. 

L�����������������  ocking Your zūmo
1.	 Touch  >  System > 

Garmin Lock. 
2.	 Touch OK, and enter a four-digit PIN. 
3.	 Re-enter your four-digit PIN. 
4.	 Touch OK. 
5.	 Drive to a security location, and touch 

Set.
Each time you turn on the zūmo, 
enter your PIN or drive to the security 
location. 

What is a Security Location?
If you are at your security location, you 
do not need to enter your PIN. If you 
forget your PIN, acquire satellite signals 
and then drive to your security location 
to unlock the zūmo. 

	Note: If you forget your PIN 
and your security location, you 
must send your zūmo to Garmin 
to get it unlocked. 
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 Where to
The Where to menu provides several 
different categories you can use to search 
for locations. 

Finding an Address
1.	 Touch  Where to >  Address. 
2.	 Select a country, state/province, and 

city/postal code, if necessary.
3.	 Enter the address number, and touch 

Done. 
4.	 Enter the street name until a list of 

streets appears, or touch Done.
5.	 Select the street and city, if 

necessary.
6.	 Select the address, if necessary. The 

Go page opens. 
7.	 Touch Go to create a route to this 

address. 

TIP:  Do not enter the street prefix 
or suffix. For example, to find North 
Main Street enter Main, and to find 
Highway 7 enter 7. 

About Postal Codes
You can search for a postal code. Enter 
the postal code instead of the city name. 
Not all map data provides postal code 
searching.

Intersections
Finding an intersection is very similar 
to finding an address. Touch  
Intersection, and enter the two street 
names. 
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Go Page Options
Touch an item in the search results list to 
view the Go page. 

Touch Go to create a turn-by-turn route 
to this location. 
Touch Show Map to view this location 
on the map. If the GPS is off, touch  
Set Loc. to set this as your current 
location. 
Touch Save to save this location as one 
of your Favorites. See page 14. 

Go Home
You can set a home location for the place 
you return to most often. 
1.	 Touch  Where to >  Go Home.
2.	 Select an option. 

Going Home
After you set your home location, you 
can route to it at any time by touching  

 Where to >  Go Home.

Changing Your Home 
Location
1.	 Touch  >  User Data > Set 

Home Location.
2.	 Select Yes, enter my Address or 

Yes, use my current location. 

Finding Points of Interest
1.	 Touch  Where to >  Food, 

Lodging.
2.	 Select a category and a sub-category, 

if necessary. (Touch the arrows to see 
more categories.) 

3.	 Select a destination. 
4.	 Touch Go.
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Finding a Location by 
Spelling the Name 
If you know the name of the location you 
are looking for, you can spell it using the 
on-screen keyboard. You can also enter 
letters contained in the name to narrow 
the search. 
1.	 Touch  Where to >  Food, 

Lodging.
2.	 Touch Spell Name.
3.	 Using the on-screen keyboard, enter 

letters in the name. Touch Done. 
4.	 Touch the location you are looking 

for, and touch Go.

Using the On-Screen 
Keyboard
When an on-screen keyboard appears, 
touch and slide the yellow box to scroll 
through the characters. Touch a character 
to enter it. 

Touch  to delete the last character 
entered; touch and hold  to delete the 
entire entry. 
Touch  to change the keyboard 
mode to use diacritical characters or 
special characters.
Touch  to enter numbers. 
To change the keyboard display, see 
page 35.
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Recently Found Locations
Your zūmo stores the last 50 of your 
recent finds in the Recently Found list. 
The most recently viewed locations 
appear at the top of the list. Touch  

 Where to >  Recently Found to 
view your recently found items. 
Touch Save > OK to add a recently 
found location to your Favorites. 
Touch Clear > Yes to delete all locations 
from the Recently Found list. 

	Note: When you delete recently 
found locations, all items are 
removed from the list. It does not 
delete the actual location from 
your unit.

Favorites
You can save up to 500 locations in your 
Favorites, so you can quickly find them 
and create routes to them. Your home 
location is also stored in Favorites. 

Saving Locations You Find
1.	 After you have found a location you 

want to save, touch Save. 
2.	 Touch OK. The location is saved in 

 Favorites. 

Sharing Locations
Share your Favorites with other zūmo 
owners. You must have an SD card 
inserted with available storage space. 
1.	 Touch  Where to >  Favorites.
2.	 Select the location you want to share.
3.	 Touch Share.
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4.	 Verify that the correct location is 
selected, and then touch Export.

5.	 Touch OK.
6.	 Eject your SD card, and insert it into 

another zūmo.
7.	 A message appears. Touch Yes to 

import the shared locations.
8.	 Touch  Favorites, and then touch 

the location you want to import.

9.	 Touch Import, and then touch OK.
10.	Touch Done to go back to the Menu 

page. 

Finding Saved Locations
Touch  Where to >  Favorites. 
The locations are listed by distance from 
your current location. Touch Spell to 
narrow your search.

Saving Your Current Location
From the Map page, touch the  
vehicle icon. Touch Yes to save your 
current location as a Favorite. 

Editing Saved Locations
1.	 Touch  Where to >  Favorites. 
2.	 Touch the location you want to edit. 
3.	 Touch Edit. 

4.	 To edit the location:
Touch Change Name. Enter a name, 
and touch Done. 
Touch Change Map Symbol. Touch 
a symbol.
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Touch Change Phone Number. Enter 
a phone number, and touch Done. 
Touch Delete to remove this item. 
A list of all your Favorites appears. 
Touch the item you want to delete. 
Touch Delete > Yes. 

Creating a Saved Route
Use your zūmo to create and save routes 
before your next trip. You can save up to 
50 routes.
1.	 Touch  Where to >  Routes > 

New.
2.	 Touch Add New Start Point.
3.	 Find a location as your starting point, 

and touch Select.
4.	 Touch Add New End Point.
5.	 Find a location as your ending point, 

and touch Select.

6.	 Touch  to add another location to 
your route. TIP: Use the Near button 
to narrow your search, see page 19. 
Touch  to remove a location. 

7.	 Touch Map to calculate your route, 
and view it on the map.

8.	 Touch Back to exit and save the 
route. 

Editing Saved Routes
1.	 Touch  Where to >  Routes.
2.	 Select the route you want to edit.
3.	 Touch Edit.
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4. To edit the route:
	 Touch Change Name. Enter a new 

name, and touch Done. 
	 Touch Add/Remove Points to add 

new start, stop, or end points to the 
route.

	 Touch Manual Reorder to change 
the order of points along your route.

	 Touch Optimal Reorder to 
automatically order the points 
according to straight line distance 
between your start and end points. 

	 Touch Recalculate to change the 
route preference to calculate by faster 
time, shorter distance, or off road.

	 Touch Delete to remove this item. A 
list of all your routes appears. Touch 
the item you want to delete. Touch 
Delete > Yes. 

	Note: Your changes are 
automatically saved when you 
exit any of the route edit pages.

Sharing Routes
Share your saved routes with other zūmo 
owners. You must have an SD card 
inserted with available storage space. 
1.	 Touch  Where to >  Routes.
2.	 Select the route you want to share.
3.	 Touch Share.

4.	 Verify that the correct route is 
selected, and then touch Export.

5.	 Touch OK.
6.	 Eject your SD card, and insert it into 

another zūmo.
7.	 A message appears. Touch Yes to 

import the shared route.
8.	 Touch Routes, and then touch the 

route you want to import.
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9.	 Touch Import, and then touch OK.
10.	Touch Done to go back to the Menu 

page. To view your imported routes, 
touch  Where to >  Routes.

	Note: You can also share routes 
using Google Earth. Go to  
http://earth.google.com. 

Finding a Location �������Using  
the Map
Touch  View map to open the Map 
page. Touch and drag anywhere on the 
Map page to browse the map and view 
different parts of the map. You can also 
touch  Where to >  >  

 Browse Map. 

Tips for Browsing the Map
•	 Touch the map and drag to view 

different parts of the map. 
•	 Touch  and  to zoom in and out. 
•	 Touch any object on the map. An 

arrow appears pointing at the object 
you selected. 

•	 Touch Back to return to the previous 
screen.

•	 Touch Save to save this location to 
your Favorites. 

•	 Touch Go to create a turn-by-turn 
route to the location. 

•	 If the GPS is off, touch Set Loc. to 
set the arrow location as your current 
location. 
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Entering Coordinates
If you know the geographic coordinates 
of your destination, you can use your 
zūmo to navigate to any location using 
its latitude and longitude coordinates. 
Touch  Where to >  >  
Coordinates. 

Touch Format to change the type of 
coordinates. Because different maps and 
charts use different position formats, the 
zūmo allows you to choose the correct 
coordinate format for the type of map 
you are using.
Touch Next for more options: 
•	 Touch Go to create a turn-by-turn 

route to the coordinates.
•	 Touch Show Map to view this 

location on the map.

•	 Touch Save to save this location to 
your Favorites.

Expanding Your Search
1.	 Touch  Where to > Near.
2.	 Select an option:

Where I Am Now—searches near 
your current location. 
A Different City—searches near the 
city you specify. 
My Current Route—searches along 
the route you are currently navigating.
My Destination—searches for 
locations near your current route 
destination.

3.	 Touch OK.

	Note: Your zūmo automatically 
searches near your current 
location. 
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Using the Main Pages

Map Page
On the Menu page, touch  View map to open the Map page. The  vehicle 
icon shows your current location. 

Map Page while Navigating a Route

Touch Speed to open 
the Trip Information 

page. 

Touch Turn In to open 
the Next Turn page. 

Touch the directions bar to 
open the Turn List page. 

Touch  to zoom out. Touch  to zoom in.

Touch Menu to return 
to the Menu page.

To save your current location, touch 
the vehicle icon, and touch Yes. 

Turn List Page Next Turn PageTrip Information Page



zūmo 400/450 Owner’s Manual	21

Using the Main Pages

Trip Information Page
The Trip Information page shows your 
current speed and provides helpful 
statistics about your trip. To view the 
Trip Information page, touch Speed on 
the Map page. 

Resetting Trip Information
If you want accurate trip information, 
reset the trip information before 
beginning a trip. If you make frequent 
stops, leave the zūmo turned on so it can 
accurately measure elapsed time during 
the trip. 
Touch Reset > Trip Data to reset the 
odometer and time information. 
Touch Reset > Max Speed to reset the 
maximum speed.
Touch More to view total time, moving 
time, and stopped time.

Using the Fuel Gauge
The fuel gauge is for motorcycle use 
only. You can track your fuel usage when 
the zūmo is in the motorcycle mount. 
The fuel gauge is only as accurate as the 
data you enter. 
1.	 On the Map page, touch Speed to 

open the Trip Information page. 
2.	 Touch Reset > Miles Per Tank.
3.	 Enter an amount, and touch Done.
4.	 A message appears when you have 

30 miles (~48.3 km) remaining.

5.	 On the Map page, touch the  icon 
to search for a nearby fuel station. 

6.	 To reset the fuel gauge, go 
to the Trip Information page, 
and touch the fuel gauge > 
Yes.
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Turn List Page
When you are navigating a route, the 
Turn List page shows turn-by-turn 
instructions for your entire route and 
the distance between turns. Touch the 
directions bar on the top of the Map page 
to open the Turn List page. Touch a turn 
on the list to view the Next Turn page for 
that turn. Touch Show Map to view the 
entire route on the map. 

Next ���������� Turn Page
When you are navigating a route, the 
Next Turn page shows the turn on the 
map and the distance and time left before 
you reach the turn. To view an upcoming 
turn on the map, touch Turn In on the 
Map page, or touch any turn from the 
Turn List page. 
Touch  and  to view other 
turns in the route. When you are finished 
viewing the Next Turn page, touch Back.
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Traffic Information
Your zūmo can receive and use traffic 
information using an optional FM 
TMC (Traffic Message Channel) 
traffic receiver. When a traffic message 
is received, your zūmo displays the 
incident on the map and can change your 
route to avoid the traffic incident. 

	Note: Garmin is not 
responsible for the accuracy of 
the traffic information. The traffic 
receiver simply receives signals 
from the traffic service provider 
and displays that information on 
your zūmo. 

  Traffic icon for North America
  Traffic icon for Europe 

Viewing Traffic Incidents
	Note: You can only access the 
traffic information if the zūmo 
is connected to a traffic receiver 
(see page 41). 

1.	 On the Menu page, touch  > 
Traffic to show traffic incidents.

2.	 Select an item to view details.
3.	 Select an option.

Avoiding Traffic
The Map page displays  or  when 
there is a traffic incident on your current 
route or on the road on which you are 
traveling. 

1.	 From the Map page, touch  or 
.
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2.	 Select an item to view details.
3.	 Touch Avoid.

Purchasing Traffic 
Subscriptions
You can renew and purchase new 
subscriptions at www.garmin.com/
fmtraffic.

Adding a �Subscription
1.	 Touch  >  >  Traffic. 
2.	 Touch Subscriptions > Add.
3.	 Follow the on-screen instructions. 

	Note: Additional 
documentation is included with 
your Garmin traffic receiver.

FM Traffic
For more information about an FM 
traffic receiver, go to www.garmin 
.com/traffic. For participating FM traffic 
subscription providers and coverage 
cities, go to www.garmin.com/fmtraffic. 

	Note: The FM traffic receiver 
and zūmo must be in data range 
of an FM station transmitting 
TMC data to receive traffic 
information. 

http://www.garmin.com/fmtraffic
http://www.garmin.com/fmtraffic
www.garmin.com/traffic
www.garmin.com/traffic
http://www.garmin.com/fmtraffic
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Managing Files on  
Your zūmo

You can load files to the internal memory 
or an optional SD card. 

	Note: The zūmo is not 
compatible with Windows® 95, 
Windows 98, or Windows Me 
operating systems. This is a 
common limitation of most USB 
Mass Storage Devices. 

Supported File Types
•	 MP3 music files
•	 JPEG and JPG image files for splash 

screen or picture viewer
•	 GPI custom POI files from Garmin’s 

POI Loader
•	 GPX waypoint files and maps from 

MapSource

	N ote: The zūmo does not 
support iTunes® M4A/M4P files. 

Step 1: Insert an SD Card 
(Optional)
To insert or remove the card, press it in 
until it clicks. 

SD card 
slot

Mini-USB port for AC 
adapter, USB Mass 
Storage mode, and 
updating software

Step 2: Connect the �����USB 
Cable
1.	 Plug the small end of the USB cable 

into the mini-USB port. 
2.	 Connect the larger end of the USB 

cable to an available USB port on 
your computer. 
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Two additional drives appear in your 
computer’s list of drives. “Garmin” 
is the available storage in the zūmo’s 
internal memory. The other removable 
disk drive is the SD card. 

	Note: If the drive is not named 
automatically, see your Help file 
or page 49 to rename the drive. 

Step 3: Transfer Files to 
Your zūmo 
For Windows
1.	 Connect the zūmo to your computer. 
2.	 Double-click  My Computer. 
3.	 Browse your computer for the file you 

want to copy. 
4.	 Highlight the file, and select Edit > 

Copy. 
5.	 Open the Garmin drive or the SD 

card drive.

6.	 Select Edit > Paste. The file appears 
in the list of files on the Garmin or SD 
card drive. 

	Note: You can also drag and 
drop files to and from your 
drives. 

For Mac®

1.	 Connect the zūmo to your 
computer. Your Garmin 
and SD card drives should 
mount onto your Mac 
desktop as two mounted 
volumes.

2.	 To copy files to your Garmin or SD 
card drive, drag and drop any file or 
folder onto the volume icon. 

Volume 
icon
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Step 4: Eject and Unplug
For Windows
When you are finished transferring files, 
double-click the  Unplug or Eject 
icon in your Windows system tray. 
Select USB Mass Storage Device, and 
click Stop. Select the drive, and click 
OK. You can unplug the USB cable from 
your zūmo now. 

For Mac
When you are finished transferring 
files, drag the volume icon to the Trash 

 (it turns into an Eject  icon) to 
unmount the device. You can unplug the 
USB cable from your zūmo now.

Deleting zūmo Files
You can delete files from your zūmo 
just as you would delete files from your 
computer.
Connect the zūmo to your computer, 
and open your Garmin or SD card 
drive. Select the file that you want to 
delete, and press the Delete key on your 
computer’s keyboard. 

	Caution: If you are not sure 
about a file’s purpose, do not 
delete it. Your zūmo memory 
contains important system files 
that should not be deleted. Be 
cautious of files located in folders 
entitled “Garmin.”
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Using the Media 
Player

Listening to MP3 Files 
Load MP3 files to the internal memory 
or an optional SD card. See pages 25–27 
for more information.
1.	 On the Menu page, touch  to 

open the Media Player. 
2.	 Touch Browse. 
3.	 Touch a category. You view a list of all 

MP3 files or view by album, artist, or 
genre.

4.	 To play the entire category from the 
beginning of the list, touch Play All. 
To play all starting with a specific 
song, touch the title. 

Album art

Touch the album art to view details 
about the MP3 file.
Touch  to adjust the volume. For 
zūmo audio options, see page 37.
Tap  to go to the beginning of the 
song; touch and hold to skip back. 
Tap  to skip to the next song; touch 
and hold to skip ahead. 
Touch  to pause the song. 
Touch  to repeat. 
Touch  to shuffle. 

	N ote: The zūmo plays MP3 
files only; it does not support 
iTunes®  M4A/M4P files. 
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Using a Playlist
This feature involves managing files on 
your zūmo (see pages 25–27).
1.	 Using your computer and an audio 

program such as Winamp™, create a 
playlist of MP3 files. 

2.	 Save the playlist as an M3U file. 

	N ote: You may need to edit the 
M3U file with a text editor, such 
as Notepad, to remove the path 
(location) to the MP3. The M3U 
file should only list the MP3 files 
in your playlist, not their location. 
Refer to the audio program’s 
Help file for instructions.

3.	 Transfer the playlist and the 
associated MP3 files to the Garmin or 
SD card drive. The M3U file must be 
in the same location as the MP3 files.

4.	 On the zūmo, touch  to open 
the MP3 player. 

5.	 Touch Browse > Import Playlist. 
The available playlists appear.

6.	 Touch a playlist to start playing the 
MP3 files. 

	N ote: You cannot change the 
order of the playlist from your 
zūmo. 
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Customizing the zūmo
1.	 From the Menu page, touch .
2.	 Touch the setting you want to change. 

Each setting contains a submenu or a 
list.

Changing the Map Settings
Touch  >  Map. 

Map Detail—adjust the amount of detail 
shown on the map. Showing more detail 
may cause the map to redraw slower. 

Map View—change the perspective of 
the map. 
•	 Track Up—display the map in 2 

dimensions (2D) with your direction 
of travel at the top.

• 	 North Up—display the map in 2D 
with North at the top.

•	 3D—display the map in 3 dimensions 
(3D) in Track Up. 

Vehicle—touch Change to change 
the icon used to show your position 
on the map. Touch the icon you want 
to use, and then touch OK. Download 
additional vehicle icons at www.garmin 
.com/vehicles.
Map Info—view the maps loaded on 
your zūmo and their version. Touch a 
map to enable (check mark) or disable 
(no check mark) that map. 
Restore—restore the default map 
settings.

http://www.garmin.com/vehicles
http://www.garmin.com/vehicles
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Changing the System 
Settings
Touch  >  System. 

GPS Mode—enable and disable GPS 
and WAAS/EGNOS. Turning on the 
WAAS/EGNOS setting might improve 
GPS accuracy, but it consumes more 
battery power. Go to www.garmin.com/
aboutGPS/waas.html for information 
about WAAS/EGNOS.
Safe Mode—turn Safe Mode on or off. 
When your vehicle is moving, Safe 
Mode disables all functions that require 
significant operator attention and could 
become a distraction while driving. 

Garmin Lock—turn on Garmin Lock 
to lock your zūmo. Enter a 4-digit PIN, 
and set a security location. For more 
information, see page 10.
About—display your zūmo’s software 
version number, unit ID number, and 
audio version number. You need this 
information when you update the system 
software (see page 39) or purchase 
additional map data (see page 40).
Restore—restore the default system 
settings.

http://www.garmin.com/aboutGPS/waas.html
http://www.garmin.com/aboutGPS/waas.html
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Localizing Your zūmo
Touch  >  Locale. 

To change a setting, touch the button 
next to the icon. 
To change all settings, touch Change 
All. In each screen, select the setting, 
and then touch OK. 
Locale—select your location.

 Text Language—set all on-screen 
text to the selected language. Changing 
the text language does not change the 
language of user-entered data or map 
data, such as street names. 

 Voice Language—set the language 
for voice prompts.

 Time Format—choose a 12-hour, 
24-hour, or UTC time format.
Time Zone—select a time zone or 
nearby city from the list. 
Daylight Saving—set to On, Off , or 
Auto, if it is available.

 Units—set units of measure to 
Kilometers or Miles. 
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Managing User Data
Touch  >  User Data. 

Set Home Location—enter or change 
your home location. See page 12. 
Import Data—load Favorites, routes, 
trip logs, and pictures from your Garmin 
drive or SD card. 
Manage Trip Log—view the current 
trip log usage. The zūmo stores your 
last 10,000 points of trip data. At the 
start of your next big trip, you may want 
to reset the trip log. Touch Clear Trip 
Log. Clearing a large trip log may take 
a few minutes. You can also reuse recent 
trip information. Touch Save As Route 
to select and save a recent trip segment 
as a route. For more information about 
routes, see page 16.

View Pictures—view pictures saved to 
your Garmin drive or SD card. Touch 
a thumbnail to view the image. Touch 
the image again to zoom using  and 

. Touch the picture and drag to view 
different parts of the picture.

To share pictures with another 
zūmo user:
1.	 Touch a thumbnail.
2.	 Touch Share. 

3.	 Verify that the correct picture is 
selected, and then touch Export.

4.	 Eject your SD card, and insert it into 
another zūmo.

5.	 A message appears. Touch Yes to 
import the shared picture.

6.	 Touch Pictures > touch a thumbnail 
> Import. 
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7.	 Verify that the correct picture is 
selected, and then touch Import.

Touch Slide Show to display each image 
for a few seconds and then display the 
next image. During the slide show, touch 
the screen at any time to stop and see 
more options.

Changing the Navigation 
Settings
Touch  >  Navigation. 

Route Preference—select a preference 
for calculating your route: 
•	 Faster Time—to calculate routes that 

are faster to drive but can be longer in 
distance. 

•	 Shorter Distance—to calculate 
routes that are shorter in distance but 
can take more time to drive. 

•	 Off Road—to calculate point-to-
point routes (without roads). On the 
Map page, touch  or press  to 
scroll to the Compass page.

Vehicle Type—specify your vehicle type 
to optimize routes. 
Avoidances—select the road types you 
want to avoid on your routes. The zūmo 
uses these road types only if alternative 
routes take you too far out of your way 
or if no other roads are available. If 
you have a traffic receiver, you can also 
avoid traffic incidents.
Attention Tone—turn on or off the 
attention tone.
Restore—restore the default navigation 
settings.
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Customizing the Display
Touch  >  Display. 

Color Mode—select Daytime for a 
light background, Nighttime for a dark 
background, or Auto to automatically 
switch between the two. 
Splash Screen—select an image to be 
shown when you turn on the zūmo. First, 
load JPEG images. See pages 25–27. 
Brightness— raise and lower the 
backlight brightness using  and . 
Screen Shot—enable Screen Shot mode. 
Touch the  camera icon to take a 
picture of the screen. The picture bitmap 
file is saved in the Garmin\scrn folder 
on the Garmin drive. 

Changing the Keyboard
Touch  >  Keyboard. 
Standard—displays a full alphabetic 
keyboard. 

Large Buttons—displays a large button 
touch-screen keyboard. This option is 
suited for motorcyclists wearing gloves. 
See page 13.
Auto—select to automatically switch 
between the standard keyboard when 
using the zūmo in the automotive mount 
(optional accessory) and the large button 
keyboard when using the zūmo in the 
motorcycle mount.
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Managing Traffic Settings
Touch  >  >  Traffic to 
view FM traffic subscription information 
and settings. You must have a traffic 
reciever connected to the unit (see  
pages 23–24).

Restoring All Settings
1.	 From the Menu page, touch . 
2.	 Touch Restore, and then touch 

Yes. This restores all of your zūmo 
settings to the factory defaults.

Clearing All User Data
	Caution: This deletes all  
user-entered information 
including Favorites, routes, trip 
logs, settings, and recent finds.

1.	 Hold your finger on the lower-right 
corner of the zūmo’s screen while 
turning on the zūmo. 

2.	 Keep your finger pressed until the 
pop-up window appears. 

3.	 Touch Yes to clear all user data. 
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zūmo Audio Options
Connect your headphones or headset to 
the zūmo to hear navigation prompts and 
MP3s. 

	N ote: For all audio features, 
you must have an external power 
source connected to the zūmo 
mount. 

Charging the zūmo
1.	 Connect the power cable to the 

mount and a power source. 
2.	 Place the zūmo in the mount, and flip 

the lever down. 

Automotive Mount 
Accessory 
You can purchase an additional mount 
for your automobile. Select a suitable 
location in your vehicle for safe cable 
routing and safe operation. Clean and 
dry the selected area of your windshield.

Mounting on Your Windshield
1.	 Place the suction cup on the 

windshield. Flip the suction lever 
back, toward the windshield. 

Power cable

Lever

Suction 
cup 

Automotive 
mount

Suction 
lever

Windshield
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2.	 Plug the power cable into the side of 
the mount.

3.	 Place the zūmo into the automotive 
mount, and flip the lever down.

Lever Suction 
cup arm, 

lever back

Mini-USB 
port

 Audio jacks

4.	 Plug the power cable into a power 
receptacle in your vehicle. Your zūmo 
should turn on automatically if the 
vehicle is running.

Mounting on Your Dashboard
Use the mounting disk to mount your 
zūmo on the dashboard and to comply 
with state regulations. 

	Note: The permanent 
mounting adhesive is extremely 
difficult to remove after it is 
installed.

1.	 Clean and dry the dashboard where 
you want to place the disk.

2.	 Remove the backing from the 
permanent mounting adhesive on the 
bottom of the disk.

3.	 Place the disk on the dashboard.
4.	 Place the suction cup part of the 

automotive mount on top of the disk. 
5.	 Flip the suction lever down (toward 

the disk).
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Removing the zūmo from the 
Mount
To remove the zūmo from the mount, 
flip up the lever on the mount. Lift out 
the zūmo. 
You can separate the suction cup from 
the automotive mount. Turn the mount as 
far as you can to the right or left. Apply 
pressure in that direction until the mount 
snaps off the arm. 

	Note: Reconnecting the 
suction cup to the automotive 
mount requires significant force. 
Press the ball end firmly into the 
socket.

To remove the suction cup from the 
windshield or mounting disk, flip the 
suction lever up. Pull the tab on the 
suction cup toward you.

U������������������  pdating the zūmo 
Software
1.	 Go to www.garmin.com/products/

webupdater to download the 
WebUpdater program to your 
computer. 

2.	 Connect the zūmo to your computer 
using the mini-USB cable.

Mini-USB port for AC adapter, USB Mass 
Storage mode, and updating software 

3.	 Run WebUpdater, and follow the 
screen prompts. After confirming 
that you want to perform an update, 
WebUpdater automatically downloads 
the update and installs it on your 
zūmo. 

http://www.garmin.com/products/webupdater/
http://www.garmin.com/products/webupdater/
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4.	 Eject and unplug your zūmo (see 
page 27).

Register your zūmo to receive 
notification of software and map 
updates. To register your zūmo, go to 
http://my.garmin.com. 
You can also download software updates 
from www.garmin.com/products/
zumo400 or www.garmin.com/
products/zumo450. Click Updates and 
Downloads, and follow the instructions. 

Purchasing and Loading 
Additional Map Data
To find out the version of the maps that 
are loaded on your zūmo, touch  
>  Map > Map Info. To unlock 
additional maps, you need your unit ID 
and serial number. 
Check www.garmin.com/unlock/update 
.jsp to see if an update for your map 
software is available. 

You can also purchase additional map 
data from Garmin and load the maps to 
the internal memory or an optional SD 
card. 
Refer to the MapSource Help file 
for more information about using 
MapSource and loading maps and 
waypoints on your zūmo. 

Optional Accessories
For more information about optional 
accessories, go to www.garmin 
.com/products/zumo400 or  
www.garmin.com/products/zumo450, 
and click the Accessories link. You 
can also contact your Garmin dealer 
to purchase accessories. Optional 
accessories include:
•	 Automotive mount
•	 Traffic receiver 
•	 External remote antenna
•	 AC adapter
•	 Extras (see pages 41–43) 

http://my.garmin.com
www.garmin.com/products/zumo400
www.garmin.com/products/zumo400
www.garmin.com/products/zumo450
www.garmin.com/products/zumo450
http://www.garmin.com/unlock/update.jsp
http://www.garmin.com/unlock/update.jsp
www.garmin.com/products/zumo400
www.garmin.com/products/zumo400
www.garmin.com/products/zumo450
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Connecting Accessories to 
Your zūmo
Some Garmin traffic receivers must be 
plugged into a mini-USB port on the 
zūmo mount. The audio jacks are located 
on the left side of the zūmo mount.

Mini-USB 
port

Audio jacks

	Tip: Carefully connect and 
disconnect cables. To disconnect, 
do not pull on the cable (cord), 
pull on the plug.

Garmin Travel Guide™ 
Much like a paper travel guide, the 
Garmin Travel Guide provides detailed 
information about locations, such as 
restaurants and hotels. To purchase the 
Travel Guide accessory, go to  
www.garmin.com/extras. 

To use the Travel Guide:
1.	 Insert the SD card into your zūmo. 
2.	 Touch  Where to >  Extras. 
3.	 Touch the Travel Guide. 
4.	 Touch a category. Touch a sub-

category, if necessary.
5.	 Touch a location in the list.
6.	 Do one of the following: 

Touch Go to go to the location. 
Touch Map to view this item on the 
map. 
Touch Save to save this location to 
your Favorites. 
Touch More to view more information 
about the location. 

http://www.garmin.com/extras
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Safety Cameras
Safety camera information is available in 
some locations. (Check http://my.garmin 
.com for availability.) For these 
locations, your zūmo includes the 
locations of hundreds of safety cameras. 
Your zūmo alerts you when you are 
approaching a safety camera and can 
warn you if you are driving too fast. The 
data is updated at least weekly, so you 
always have access to the most up-to-
date information.

To get updated safety camera 
information:
1.	 Go to http://my.garmin.com.
2.	 Sign up for a subscription.
You can purchase a new region at 
any time, and you can extend existing 
subscriptions at any time. Each region 
that you purchase has its own expiration 
date.

Custom ������ ����������� POIs (Points of 
Interest)
Load custom points of interest (POIs) 
onto your zūmo. POI databases are 
available from various companies on the 
Internet. Some custom databases contain 
alert information for points, such as 
school zones. A warning appears if you 
are traveling too fast near these custom 
POIs.
Use the Garmin POI Loader to load 
POIs on your Garmin drive or SD card. 
Download the POI Loader from  
www.garmin.com/extras.
Refer to the POI Loader Help file for 
more information; press F1 to open the 
Help file. 
To view your custom POIs, touch  

 Where to >  Extras >  
Custom POIs. 
To turn on or off custom POIs, touch 

 >  Proximity Points > 
Proximity Alerts. 

http://my.garmin.com
http://my.garmin.com
http://my.garmin.com
http://www.garmin.com/extras
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To delete the custom POIs from your 
zūmo, connect your zūmo to your 
computer. Open the Garmin\poi folder 
in the Garmin or SD card drive. Delete 
the file entitled poi.gpi.

	 Caution: Garmin is not 
responsible for the consequences 
of using a custom POI database 
or the accuracy of the safety 
camera or other custom POI 
database. 

Garmin TourGuide™ 
The Garmin TourGuide allows your 
zūmo to play third-party, GPS-guided 
audio tours. These audio tours can take 
you on a route while playing interesting 
facts about historical sites along the way. 
As you travel, the audio information 
is triggered by GPS signals. For more 
information, go to www.garmin.com/
extras and click POI Loader.

To view your Garmin TourGuide files, 
touch  Where to >  Extras >  
Custom POIs. 
To change the Garmin TourGuide 
settings, touch  >  Proximity 
Points > TourGuide. Select Auto 
Play to hear the complete tour as 
programmed, Prompted to show the 
speaker icon  on the map when tour 
information is available during your 
route, or Off. 

SaversGuide®

The SaversGuide is an optional 
accessory that is available only in North 
America (www.garmin.com/extras). 
With the SaversGuide preprogrammed 
SD data card and membership card, 
your zūmo is a digital coupon book that 
notifies you of merchants near your 
current location where you are eligible 
for a discount, such as restaurants, 
hotels, and movie theaters.

http://www.garmin.com/extras
http://www.garmin.com/extras
http://www.garmin.com/extras
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Battery Information 
	NOT E: See the Important Safety 
and Product Information guide 
for battery warnings. 

Your zūmo contains an internal lithium-
ion battery. The battery lasts up to 4 
hours, depending on usage. 
The  battery icon on the Menu 
page indicates the status of the internal 
battery. If the icon is not present, your 
zūmo is connected to external power. For 
information about charging your zūmo, 
see page 37.

Maximizing the Battery Life
•	 Turn off GPS (  >  System  

> GPS Mode > GPS Off) when you 
do not need to receive GPS signals, 
or use Normal mode when WAAS or 
EGNOS is not available.

•	 Turn the backlight brightness down. 
Press and hold , and then use  
and  to adjust the brightness. 

•	 Do not leave your zūmo in direct 
sunlight. Avoid prolonged exposure 
to excessive heat or cold. 

Replacing the Battery
To purchase a replacement lithium-ion 
battery pack, go to www.garmin.com/
products/zumo400 or www.garmin 
.com/products/zumo450, and click the 
Accessories link. 
Unscrew the battery pack and replace 
the battery. Contact your local waste 
disposal department for information on 
properly disposing of the battery. 

MCX 
connector 

under 
weather cap 

Battery 
pack

Screw

www.garmin.com/products/zumo400
www.garmin.com/products/zumo400
www.garmin.com/products/zumo450
www.garmin.com/products/zumo450
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Using a Remote Antenna
You can use an optional external remote 
antenna (Garmin GA 25MCX). To 
purchase, go to www.garmin.com/
products/zumo400 or www.garmin 
.com/products/zumo450, and click the 
Accessories link. 
Pull back the weather cap from the MCX 
connector located on the back of the 
zūmo, and connect the antenna. 

About GPS ������������������ Satellite Signals
Your zūmo must acquire GPS (Global 
Positioning System) satellite signals 
to operate. If you are indoors, near tall 
buildings or trees, or in a parking garage, 
your zūmo cannot acquire satellites. 
Go outside to an area free from tall 
obstructions to use your zūmo. 
When your zūmo has acquired satellite 
signals, the signal strength bars on the 
Menu page are green . When it 
loses satellite signals, the bars turn red or 
disappear . 
For more information about GPS, go to 
www.garmin.com/aboutGPS.

www.garmin.com/products/zumo400
www.garmin.com/products/zumo400
www.garmin.com/products/zumo450
www.garmin.com/products/zumo450
http://www.garmin.com/aboutGPS
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Specifications
Physical size: 4.4” W x 3.2” H x  
2.87” D (11.3 x 8.2 x 7.2 cm)
Weight: 0.59 pounds (269 g)
Display: 2.8” W x 2.1” H (7.2 x 5.4 cm); 
320 x 240 pixels; bright, 16-bit LCD, 
with white backlight and touch screen
Case: IPX7 waterproof
Temperature range: 32°F to 140°F (0°C 
to 60°C)
Data storage: Internal memory and 
optional removable SD card. Data stored 
indefinitely.
Computer interface: USB mass storage, 
plug-and-play
Charge time: Approximately 6 hours
Power input: 12 VDC
Usage: 15 W max. @ 13.8 VDC
Battery life: up to 4 hours depending on 
usage

GPS Performance 
Specifications
Receiver: WAAS enabled
Acquisition times*: 
Warm: < 1 sec 
Cold: < 38 sec 
Factory Reset: < 45 sec
*On average for a stationary receiver 
with a clear view of the sky
Update rate: 1/sec, continuous
GPS accuracy:
Position: < 10 meters, typical
Velocity: 0.05 meter/sec RMS
GPS (WAAS) accuracy:
Position: < 5 meters, typical
Velocity: 0.05 meter/sec RMS
For a complete list of specifications, go 
to www.garmin.com/products/zumo400 
or www.garmin.com/products/zumo450, 
and click Specifications.

www.garmin.com/products/zumo400
www.garmin.com/products/zumo450
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zūmo Troubleshooting
Problem/Question Solution/Answer

My battery gauge does 
not seem accurate.

Allow the unit to fully discharge and then fully charge it (without 
interrupting the charge cycle).

The touch screen is not 
responding to my taps 

properly.

Calibrate the touch screen . Turn the unit off. Press and hold 
 for about one minute until the Calibration screen appears. 

Follow the on-screen instructions.

The zūmo freezes up. Reset the zūmo. Press and hold  and press .

How do I clean the 
zumo?

The zūmo is constructed of high-quality materials and does not 
require user maintenance other than cleaning. Clean the unit’s 
outer casing (not the touch screen) using a cloth dampened with 
a mild detergent solution, and then wipe dry. Avoid chemical 
cleaners and solvents that can damage plastic components.

How do I clean the 
touch screen?

Clean the touch screen with a soft, clean, lint-free cloth. Use 
water, isopropyl alcohol, or eyeglass cleaner, if needed. Apply 
the liquid to the cloth, and then gently wipe the touch screen.

The suction cup will not 
stay on my windshield.

Clean the suction cup and windshield with rubbing alcohol. Dry 
with a clean, dry cloth. Mount the suction cup as described on 
page 37.
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USB Interface Troubleshooting
Problem/Question Solution/Answer

How do I know my 
zūmo is in USB Mass 

Storage Mode?

When your zūmo is in USB Mass Storage Mode, a picture of a 
zūmo connected to a computer is shown. Also, you should see 
a new removable disk drive listed in My Computer (Windows) or 
a new volume (drive) on your desktop (Mac). 

My computer never 
senses that the zūmo is 

connected.

1.	 Unplug the USB cable from your computer. 
2.	 Turn the zūmo off. 
3.	 Plug the USB cable into your computer and your zūmo. 

The zūmo automatically turns on and goes into USB Mass 
Storage Mode. 

I cannot find any drives 
named “Garmin” in my 

list of drives.

If you have several network drives mapped on your computer, 
Windows may have trouble assigning drive letters to your 
Garmin or SD drives. Follow the steps on the next page to 
assign (map) your drive letters. 

I get a message saying 
“Unsafe Removal of 

Device” when I unplug 
the USB cable.

Windows: Double-click the Unplug or Eject  icon in your 
system tray. Select USB Mass Storage Device and click Stop. 
Select the Garmin drive and click OK. You can unplug your 
zūmo now. 
Mac: Drag the volume icon to the Trash. The Trash icon 
changes to an Eject icon. You can unplug your zūmo now.
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Problem/Question Solution/Answer

How can I rename 
my Garmin drives in 

Windows?

1.	 Open My Computer. 
2.	 Select the drive you want to rename. 
3.	 Right-click your mouse, and select Rename. 
4.	 Type the new name, and press the Enter key on your 

computer’s keyboard. 

How do I assign (map) 
my Garmin ����������� drives in 

Windows?

1.	 Turn off your zūmo. 
2.	 Plug the USB cable into the zūmo and your computer. Your 

zūmo automatically turns on. 
3.	 Click Start > Settings > Control Panel > Administrative 

Tools > Computer Management > Storage > Disk 
Management. 

4.	 Click a zūmo removable disk drive (either the internal 
memory or your SD card drive). Right-click your mouse, and 
select Change Drive Letter and Path.

5.	 Select Edit, select a drive letter from the drop-down list, and 
click OK. 
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Symbols
2-D, 3-D map view  30
A
About button  31
accessories  40
address  11
add a stop  9
alerts, safety camera  42
antennas  40, 45
anti-theft feature  10, 31
audio

jacks  3, 38, 41
options  37
version  31

automotive mount  37
avoiding

road types  34
traffic  34

B
battery  44, 46
better route  10
brightness  2, 35
browsing the map  18
C
calibrating the touch screen  47
caring for your zūmo  iv
car installation  37
charging the zūmo  37

cleaning  47
clearing user data  36
Compass page  34
computer connection  25
contact Garmin  i
coordinates  19
current location, saving  15
customizing your zūmo  30–36
Custom POIs  42
D
dashboard mount  38
data storage drives  25, 46
daylight saving  32
Declaration of Conformity  iv
deleting

all user data  36
character  13
custom POIs  43
Favorites  16, 17
files  27

detail maps  30
detours  10
diacritical characters  13
display settings  35
drives, Garmin  26
driving directions  22
E
editing saved places  15
EGNOS  31
ejecting the USB  27
expanding your search  19

Extras  41–42
F
Favorites  14

editing  15
finding  15
saving  14
sharing  14

FCC compliance  iv
files

deleting  27
managing  25, 33
supported types  27
transferring  25–27

finding places
by address  11
by coordinates  19
by name  13
by postal code  11
intersection  11
item on the map  18
near another location  19
saved places (Favorites)  15

FM traffic  24
fuel gauge  21
G
Garmin Lock  iv, 10, 31
Garmin TourGuide

playing files  43
Garmin Travel Guide  41
going home  12–19
Google Earth  i
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Go page  12
GPS  7, 45
H
home location  12
I
importing data  33
intersection  11
K
keyboard  13, 35
kilometers  32
L
languages  32
loading additional maps  40
locking your zūmo  10
M
M3U playlist  29
managing files  25–27
map

browse  18
customize  30
Map Info button  30
moving  18
update maps  39
using the Map page  18, 20
version  30
view  18, 30
zoom  18

MapSource  i, 25, 40
menu page  7
miles  32

mini-USB. See USB
motorcycle installation  3
mounting the zūmo

in a car  38
on a motorcycle  3

MP3 files
loading  25
playing  28

myGarmin  i, 40, 42
N
navigation settings  34
Near button  19
Next Turn page  22
North Up map view  30
O
off road, routing  17, 34
P
picture viewer  33
PIN

Garmin Lock  10
playing music  28
playlist  29
POIs, custom  42
position icon  20, 30
postal code  11
protecting your zūmo  iv
R
recently found location  14
registering your zūmo  40
remote antenna  45

removable disk drive  26
removing the mount  39
resetting

the max speed  21
the trip data  21
your zūmo  47

restoring settings  36
routes  16–18
routing preferences  34
S
safety cameras  42
Safe Mode  31
satellite signals  7, 45
SaversGuide  43
saving

places you find  12, 14
routes  16
your current location  15, 18

school zone database  42
Screen Shot mode  35
SD card  1, 25, 46

sharing  14, 17
security location  10
settings  30–36
setting your location  12, 18
sharing

Favorites  14
pictures  33
routes  17

show map  12, 22
slide show  34
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software
updating  39
version  31

special characters  13
specifications  46
spelling the name of a place  13
splash screen  35
storing your zūmo  iv
supported file types  25
system settings  31
T
text language  32
time format  32
time zone  32
tones  34
touch screen

aligning  47
cleaning  47

Track Up map view  30
traffic

avoiding  23, 34
incidents  23
settings  36
subscriptions  24

transferring files  25–27
Trip Information page  21
trip log  33
troubleshooting  47–49
turn-by-turn directions  22
Turn List page  22

U
unit ID  31
updating

maps  40
zūmo software  39

USB
mass storage mode  25–27
ports  1, 25, 38, 39, 41
troubleshooting  47

user data  33
V
vehicle icon  20, 30
vehicle type  34
view pictures  33
voice language  32
volume  2
W
WAAS  31
weather cap  iv
WebUpdater  39
Z
zoom  18, 20, 33



For the latest free software updates (excluding map data) 
throughout the life of your Garmin products, visit the Garmin 

Web site at www.garmin.com.
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